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Training Agenda 

1. Business Manager-Supervisor 
Introduction 
a. Workspace 
b. Views/Licenses 
c. Help 
 

2. System Views 
 

3. Workgroup Views 
a. Agent Overview 
b. Agent Detail 
c. Workgroup Overview 
d. Workgroup  Detail 

 
4. Workgroup Functions 

a. Listen, Coach, Join 
b. Activation/De-activation 
c. Change User Status 
 

 
 
 

 

5. Graphs 
a. Agent Graph 
b. Workgroup Graph 

 
6. Alerts 

a. Statistic alerts 
b. Status Change alerts 

 
7. Assistance Response 

 
8. Reports 

a. Historical Reports 
b. Report Assistant 
c. Interaction Reporter 

 
9. Q&A 
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• Although the Interaction Client provides limited user, workgroup and 
queue monitoring capabilities, Business Manager-Supervisor is more 
powerful, summarizes additional operational statistics and provides 
alerts.   
 

• It allows a user to: 
• Monitor individual agents 
• Monitor multiple agents 
• Monitor single workgroups 
• Monitor multiple workgroups 
• Set alerts to inform of events triggered by statistical changes 

• Display, Sound, Email, .NET client message 
• View real-time statistics in graphs and consolidated tables 
• Respond to agent Assistance requests 
• Run Interaction Reporter 

 

Interaction Supervisor Introduction 
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Interaction Supervisor Introduction 

Workspace 

• Supervisor is a 
component of IC 
Business Manager 

• When you start IC 
Business Manager for 
the first time, the main 
window or workspace 
will be blank. 

• When views are added, 
they appear within IC 
Business Managers 
workspace as tabs by 
default. 

• Once views are 
arranged, the 
workspace will be 
‘remembered’ upon 
exiting and re-entering 
Supervisor.   
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• Workspaces will contain 

one or more views and 
can be organized by tasks 

• There will be built-in 
workspaces that can not 
be deleted 

• Ability to create custom 
workspaces with one or 
more views for a specific 
task is available 
 

Interaction Supervisor Introduction 

View 

Workspaces 
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Licenses 
To view and use views, 
licenses must be assigned to 
your user/station 

• Historical Reports 
Supervisor Plug-In 

• Interaction Feedback 
Access 

• Interaction Recorder 
Client Access 

• Interaction Recorder 
Quality Monitoring 

• Optimizer Supervisor 
Plug-In 

• System Status 
Supervisor Plug-In 

• Workgroup Supervisor 
Plug-In 

Interaction Supervisor Introduction 
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Help 

Use the Help Menu for 
information regarding views 
and how to use them 

• Historical Reports 
• Interaction Feedback 
• Interaction Recorder 
• Interaction Report 

Assistant 
• Interaction Reporter 
• Interaction 

Supervisor 
• Interaction Tracker 
• Optimizer 

Administration 

Interaction Supervisor Introduction 
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Select New 
Select View… 
Group by: Categories 
Select System Status 
 
The following views will be 
available: 

• License statistics 
• Queues 
• Session Managers 
• System Graph 
• System Statistics 

Interaction Supervisor - System Views 
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Shows the license items 
ordered 
 
Able to see the available and 
used licenses in both numeric 
and percentage form 
 
 
 

System Views – License Statistics 
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Allows users to examine 
Interactions within a queue 
and pick them up, disconnect 
them, place them on hold, 
listen in on them, join them, 
coach the agent on them, or 
record them 
 
4 queues are available 

• Line Queue 
• Station Queue 
• Workgroup Queue 
• User Queue 

System Views – Queues  

Queue Type 



Innovation • Experience • Value www.inin.com 
 ©2011 Interactive Intelligence, Inc. 

Session Managers maintain the 
state and operation of IC client 
applications 
 
The Session Manager View 
allows users to view the 
session managers and any 
client connected to them and 
the statistic related to the client 

System Views – Session Managers 
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Presents the relation of various 
system statistics into a single 
graph 
 
Categories of System Statistics 
that are available: 

• Email 
• Fax 
• IC Memory Usage 
• IC Performance 
• PMQ 
• Recording 
• Speech Recognition 
• IC System Status 
• Tracker Server 
• Transaction Server 

System Views – System Graph 
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Used to monitor the health of an 
IC server as it reports activity on 
the IC subsystems and queues.  

System Views – System Statistics 
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Select New 
Select View… 
Group by: Categories 
Select Agents and 
Workgroups 
 
The following views will be 
available: 

• Agent Details 
• Agent Graph 
• Agent or Workgroup 

Queue 
• Agent Overview 
• Workgroup Details 
• Workgroup Directory 
• Workgroup Graph 
• Workgroup Overview 
• Workgroup Statistics 

 

Interaction Supervisor - Agents and Workgroups 
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Select New 
Select View… 
Group by: Categories 
 
Select the Agent Overview view 
from the right hand menu 

Workgroup Views – Agent Overview 
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Select the workgroup where the agent 
belongs or select [All] to see all the 
agents 

Workgroup Views – Agent Overview 
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Select the agents or agents 
you want to get an overview on 

Workgroup Views – Agent Overview 
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Select the Interval and Queue 
Statistics you would like to see 
 
Interval Statistics: 

• Current Period 
• Current Shift 
• Previous Period 
• Previous Shift 

Queue Statistics: 
• Interactions Received 
• Interactions answered 
• Interactions completed 
• Longest interaction waiting 
• Longest talk time 
• Average wait time 
• Average talk time 
• Non-ACD interactions 
• Average agent positive score 
• Average agent negative score 
• Average customer positive 

score 
• Average customer negative 

score 
 

 

Workgroup Views – Agent Overview 
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• The Agent Overview view 
consolidates multiple 
agent statistics in an 
expandable table, so that 
an agent's performance 
can be compared to other 
agents in various 
workgroups. 

• Expand the +/- sign next 
to the agent names to see 
statistics per workgroup. 

• The statistics you have 
selected are on the right. 

• Right click and choose 
‘Add/Remove Statistics’ to 
change the agents or 
statistics. 

 

Workgroup Views – Agent Overview 
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Select New 
Select View… 
Group by: Categories 
 
Select the Agent Details view from the 
right hand menu 

 

Workgroup Views – Agent Details 
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Select the agent you want a detailed 
report on 

Workgroup Views – Agent Details 
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Select one of the workgroups that 
agent belongs in or select [All] if you 
want to include all the workgroups the 
agent belongs in 

Workgroup Views – Agent Details 
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This view summarizes the 
activity of a single agent 
for a single workgroup or 
all the workgroups the 
agent belongs in 
 
The statistics you have 
selected are in the rows, 
and the periods/shifts in 
the columns 
 
Right click and choose 
‘Add/Remove Statistics’ to 
change the period/shifts or 
statistics 
 

Workgroup Views – Agent Details 
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Select New 
Select View… 
Group by: Categories 
 
Select the Workgroup Overview 
view from the right hand menu 
 

Workgroup Views – Workgroup Overview 
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Select the workgroup or 
workgroups you like to get an 
overview on 

Workgroup Views – Workgroup Overview 
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Select the statistics you would like to see in the 
overview list 
 
Available Statistics: 

• Total Agents 
• Logged in 
• Available for ACD interactions 
• Not available for ACD interactions 
• Percent available 
• Longest available 
• On inbound ACD interactions 
• On inbound ACW 
• Longest inbound ACD interactions 
• On outbound ACD interactions 
• On outbound ACW 
• Longest outbound ACD interaction 
• On no-ACD interactions 
• Longest non-ACD interaction 
• Interactions waiting 
• Interactions answered 
• Longest interaction waiting 
• Longest talk time 
• Agents logged in on this workgroup 
• Agents available 
• Lowest active agent negative score 
• Lowest active customer negative score 

Workgroup Views – Workgroup Overview 
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Workgroup Views – Workgroup Overview 

Select the Interval and Queue 
Statistics you would like to see 
 
Interval Statistics: 

• Current Period 
• Current Shift 
• Previous Period 
• Previous Shift 

Queue Statistics: 
• Interactions Received 
• Interactions answered 
• Interactions completed 
• Longest interaction waiting 
• Longest talk time 
• Average wait time 
• Average talk time 
• Non-ACD interactions 
• Average agent positive score 
• Average agent negative score 
• Average customer positive score 
• Average customer negative score 
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The Workgroup Overview view 
consolidates multiple workgroup 
statistics in an expandable table 
control, so that an workgroup's 
performance can be compared 
to each other. 
 

The workgroups you have 
selected will be the rows. The 
statistics you have selected are 
columns on the right. 

 

Right click to change the 
workgroups or statistics 

Workgroup Views – Workgroup Overview 
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Workgroup Views – Workgroup Details 

Select New 
Select View… 
Group by: Categories 
 
Select the Workgroup  
Details view from the right 
hand menu 
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Select the workgroup you like to 
get an detailed overview on 
 

Workgroup Views – Workgroup Details 



Innovation • Experience • Value www.inin.com 
 ©2011 Interactive Intelligence, Inc. 

The Workgroup Details view 
displays details about a selected 
workgroup such as the status of 
individual members and 
statistics on the workgroup 
itself. 
 
You can see active calls within 
the queue, whether if the call is 
assigned or not. 
 
The bottom of the view can 
show the member’s status by 
clicking on the Members tab. 
 
Right click and choose 
‘Add/Remove Statistics’ to 
change the period/shifts or 
statistics. 
 

Workgroup Views – Workgroup Details 
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The bottom half of the 
Workgroup Details view 
shows the calls currently 
in the queue.  
 
Additional columns of 
information can be added 
in the Queue tab by right 
clicking on the column 
headers 
 
Supervisors can click on 
a call in the queue and 
either Listen, Coach, 
Join, Pickup, Transfer the 
Call, etc 
 

Workgroup Functions – Call Control 
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If a user is activated in a 
workgroup, they can take 
ACD Interactions and if they 
are deactivated, they will not 
receive ACD Interactions.  
 
The Workgroup Details 
view, allows you to activate 
or deactivate a user 
 
Right click a user in the 
workgroup and select 
‘Manage Workgroup 
activations’ 
 
You can select members 
and make them active or 
deactivate them for the 
particular workgroup 
selected. 
 
 
 
 
 

Workgroup Functions – Member Activation 
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Supervisors can change the 
status of workgroup 
members from the 
Workgroup Details view 
 
Right click a user in the 
workgroup that you want to 
change the status on and 
select ‘Change Status for 
Users Name’ 
 
You can select the status 
from the drop down in order 
to change 

Workgroup Functions – Change User Status 
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Select New 
Select View… 
Group by: Categories 
 
Select the Agent Graph view from 
the right hand menu 
 

Agent Graph 
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Select the workgroup you 
want to select agents from or 
select [All] if you want to list 
all the agents in the system 

Agent Graph 
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Select the agents you 
want to list on the graph 

Agent Graph 
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Select the Interval and Queue 
Statistics you would like to see 
 
Interval Statistics: 

• Current Period 
• Current Shift 
• Previous Period 
• Previous Shift 

Queue Statistics: 
• Interactions Received 
• Interactions answered 
• Interactions completed 
• Longest interaction waiting 
• Longest talk time 
• Average wait time 
• Average talk time 
• Non-ACD interactions 
• Average agent positive score 
• Average agent negative score 
• Average customer positive 

score 
• Average customer negative 

score 

Agent Graph 
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The Agent Graph view shows 
the statistics  you selected of 
1 or more agents 
 
The generated graphs will 
allow comparison if 2 or more 
agents are selected 
 
Change the chart type by 
right clicking and select 
‘Chart Type’ 
 
 

Agent Graph 
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Select New 
Select View… 
Group by: Categories 
 
Select the Workgroup Graph 
view from the right hand menu 
 

Workgroup Graph 
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Select the workgroup or 
workgroups you want to 
list on the graph 

Workgroup Graph 
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Workgroup Graph 
Select the statistics you would like to see on the 
workgroup graph 
 
Available Statistics: 

• Total Agents 
• Logged in 
• Available for ACD interactions 
• Not available for ACD interactions 
• Percent available 
• Longest available 
• On inbound ACD interactions 
• On inbound ACW 
• Longest inbound ACD interactions 
• On outbound ACD interactions 
• On outbound ACW 
• Longest outbound ACD interaction 
• On no-ACD interactions 
• Longest non-ACD interaction 
• Interactions waiting 
• Interactions answered 
• Longest interaction waiting 
• Longest talk time 
• Agents logged in on this workgroup 
• Agents available 
• Lowest active agent negative score 
• Lowest active customer negative score 
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Workgroup Graph 
Select the Interval and Queue 
Statistics you would like to see 
 
Interval Statistics: 

• Current Period 
• Current Shift 
• Previous Period 
• Previous Shift 

Queue Statistics: 
• Interactions Received 
• Interactions answered 
• Interactions completed 
• Longest interaction waiting 
• Longest talk time 
• Average wait time 
• Average talk time 
• Non-ACD interactions 
• Average agent positive score 
• Average agent negative score 
• Average customer positive 

score 
• Average customer negative 

score 
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The Workgroup Graph will 
display all the statics select in 
both graph and numeric form 
 
The generated graphs will 
allow comparison if 2 or more 
agents are selected 
 
Change the chart type by right 
clicking and select ‘Chart 
Type’ 

Workgroup Graph 
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If you have multiple tabs open 
in a Workspace you can 
arrange them to view multiple 
at the same time or use 
Slideshow mode that cycles 
through open tabs. 
 
To show multiple tabs at the 
same time, left click and drag 
tab header until the zones 
image appears. Hover over 
the different zone to see 
where the tab will be placed. 
Let go on the zone you wish to 
place the tab. You can also 
drag tabs to any order or drag 
the tab off the workspace to 
be by itself. 
 
To show in Slideshow mode, 
click View from the menu 
options, then Show slide 
show. 

Organizing Views 
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An alert notifies when a 
statistic is in or out of a user-
defined range, based on the 
value of a statistic. 

When an alert becomes 
active, it can play a sound, 
change the color of text or an 
icon, send an Email, or send a 
Supervisor Message. 

Easiest way to create an alert 
is by right clicking on the 
statistic you want to alert on, 
and choosing ‘Edit Alerts’.  

This will pre-fill the 
agent/workgroup and statistic 
fields on the Edit Alerts dialog 
box. 

 

Alerts 
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Alert conditions allow you to specify 
the parameters that have to be met 
to trigger the alert.  

Alerts 

Severity level is an optional value 
that can colorize the icon that is 
shown when an alert is triggered 
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One or more actions can be 
selected for a alert when its 
triggered 
 
Available Actions: 
• Show the statistic 
• Play a sound on the computer  
• Send an email to one or more 

people 
• Execute a custom handler 
• Send a client memo 

Alerts 
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Supervisor Messages 

 

-Need Supervisor Message 
creation permissions setup 
by Administrator 

-Sends Messages to the 
bottom of the.NET client or 
as a ‘Desktop Pop-up’ (or 
toast). 

 

Usage Example: You could 
set an alert on Interactions 
Waiting > 20 to send a 
Supervisor Message to 
agents that are currently 
deactivated to tell the to 
activate themselves in the 
workgroup to help with 
volume. 

 

Alerts 
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Active Alerts 

From the Tools menu select 
View Active Alerts. 

Shows alerts that are 
currently triggered. 

 

Manage Alerts 

From the Tools menu select 
Manage Alerts. 

Shows all alerts, alerts in a 
specific category, or by filter. 

Alerts 
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Status Change Alerts 

From the Members tab in a 
Workgroup view, right click 
on a user and choose ‘Edit 
Alerts’. 

 

The Edit Alerts dialog box 
will appear. You can select 
what status for which you 
wish to create an alert. 

 

After this selection click Add 
and the Alert dialog will be 
presented. Same options as 
adding a single alert. 

 

Alerts 
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Assistance Response 
Workgroup Supervisor 
associations are configured 
in Interaction Administrator 
in each workgroup.  

In order for the request 
assistance process to work 
properly, at least one 
supervisor must be 
configured for your 
workgroup in Interaction 
Administrator on the 
Roles/Supervisor tab and at 
least one supervisor for your 
workgroup must be logged 
in.  

Supervisors receive 
assistance requests only if 
they are running IC 
Business Manager. They do 
not receive assistance 
requests if they are running 
only Interaction .NET Client.  

 

When an agent needs help and sends 
a Assistance Request, a toast pop 
opens on the Supervisors screen 

You can manage all Assistance Requests from the 
Agent Assistance window 
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The supervisor can either 
click Respond or Ignore 
the request in the toaster 
pop or Agent Assistance 
window 
 
If an supervisor ignores 
the request, the 
Assistance Request stays 
active and can pick it up at 
another time or another 
supervisor can pick up the 
request 
 
Multiple supervisors can 
join an Assistance 
Request 
 
 

Assistance Response 
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When a request is accepted, a 
chat window opens with the agent 
 
The supervisor can chat with the 
agent  
 
Telephony options are available 
as well if the agent needs to join 
the call, listen in, or coach the 
agent 

Assistance Response 
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Historical Reports 

Select New View 

Select the Historical 
Reports category and 
then the Historical 
Reports view, then OK. 

-This requires a valid 
Historical Reports 
license.  

Reports - Historical 
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Select a report by clicking 
on a row in the list.  

Note the Historical 
Reporting dropdown 
menu, especially for 
Report Help. 

Expand and/or scroll to 
the Description column to 
see the contents of the 
reports. 

Start the report by double 
clicking on the specific 
row. 

Reports - Historical 
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The Reports Parameters 
dialog box is displayed.  

The tabs will differ 
depending upon the 
report. Typical tabs 
(parameters) include 
queues, date/time, shifts, 
etc.  

The !-zzz means ‘ALL’ 
when referring to Agents 
or Queues. 

Reports - Historical 
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When changing Date/Time 
parameter, it is easiest to 
do in the following way: 

1) Click on the parameter 
in the lower box. 

2) This will change the 
dates in the range boxes. 

3) Adjust the dates in the 
ranges boxes. 

4) Click add to insert in 
the parameter box. 

5) Highlight the old 
parameter  in the lower 
box (now that there are 
two) and delete. 

Click Run 

Note: the final parameters 
always need to be in the 
lower boxes on each tab. 

Reports - Historical 
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The Crystal Reports 
window will open with the 
report displayed. 

The toolbar at the top 
allows for: Printing, 
Exporting, Zooming, or 
changing to different 
pages. 

Depending upon the 
report, sub-report or 
breakdown are available in 
the left hand column or by 
clicking on a statistic 
when the arrow changes 
to a magnifying glass. 

Click the X in the upper 
right hand corner to close 
the report. 

Reports - Historical 
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The Reports Parameters 
can be saved for quick 
use next time. 

For example, if you always 
run a report with the same 
3 queue names or agent 
names. 

After the parameters are 
filled in, simply click on 
the Save button, and name 
the Parameter set, and 
click Save. 

Next time simply choose 
Load from the parameters 
dialog box and select the 
Parameter set to Load. 

Note: These parameter 
sets are save per user per 
machine and are not 
global.  

Reports - Historical 
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Report Assistant 

Select New View 

Select the Historical 
Reports category and 
then the Report 
Assistant view, then OK  

-This requires a valid 
Report Assistant 
license.  

Reports – Report Assistant 
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The Report Assistant 
application will start the 
wizard. 

 

At the Report Assistant 
welcome screen click 
Next. 

Reports – Report Assistant 
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Choose a Data Package. 

 

Choose a Layout. 

 

Click Next. 

Reports – Report Assistant 
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Choose  fields from the 
Available Fields box on 
the left, to put into the 
Column Fields on the right 
for the pieces of data you 
want in your report. 

 

Click on the blue arrows 
to move fields between 
boxes. 

 

Click Next. 

Reports – Report Assistant 
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Choose  Site ID (usually 0 
or 1). 

 

Dependent on the report, 
choose additional data 
and then Add. 

 

Click Next. 

Reports – Report Assistant 
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Dependent on the report, 
choose additional Filters. 

 

Click Next. 

Reports – Report Assistant 
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Dependent on the report, 
choose additional Groups 
and Summaries. 

 

Click Next. 

Reports – Report Assistant 
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Choose Report 
Orientation and click 
Finish. 

 

Reports – Report Assistant 
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The report will be 
displayed. 

The toolbar at the top 
allows for: Printing, 
Exporting, Zooming, or 
changing to different 
pages. 

Use the Report menu 
options to change design, 
inputs, filters, etc. 

 

Use File > Save As if you 
wish to save the report for 
future re-use. 

Use File > Recent Files to 
load a previously saved 
report. 

Click the X in the upper 
right hand corner to close 
the application. 

Reports – Report Assistant 
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Interaction Reporter allows you 
to easily create pre-defined 
reports using filters. These filters 
can be saved to run the report 
again and can be exported to a 
file.  
 
Click on the Interaction Reporter 
workspace. 
 
Reports are organized into 5 
categories: 
• Line Reports 
• Queue Reports 
• Recorder 
• User Reports 
• Wrap Up Codes  

Reports - Interaction Reporter 
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To get started, select the 
Interaction Reporter icon 
from the left hand menu 
in IC Business Manager 

Reports - Interaction Reporter 
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Select a type of report 
you would like to run and 
double click it to open the 
filter configuration screen 
 
Add additional 
parameters to filter on as 
you seem fit 
 
Enter in filter information 
for the report such as the 
time range 
 
Click ‘Run Report’ to 
generate the report 
according the filter 
information 
 

Reports - Interaction Reporter 
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Reports - Interaction Reporter 

The report will be displayed. 

The toolbar at the top allows 
for: Printing, Zooming, or 
changing to different pages. 

 

Click ‘Show Parameters’ to 
go back to the filter 
configuration to edit the 
filters again 
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Once a report is created that 
you would like to share with 
other Supervisors, the filter can 
either be saved as a file or 
saved on the IC Server 
 
To save to a file, click ‘Import’ 
 
To save to the IC server, click 
‘Save’ 

Reports - Interaction Reporter 



Conclusion – Q & A 



Thank You! 


